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Introduction
Belgium Address Data Information

Dataset Code: BEL

Approximate Data Size: 10MB

Data Source: Arvato Data Services N.V.

Update Frequency: Quarterly

The quarterly data release dates are:

l February

l May

l August

l November

Expiry: Data files will expire 13 months after creation.

Ensure every data update is applied promptly, otherwise the data may
expire and the product will become unusable.

List Of Available Data Files

File Extension File Type Comment

.dts Dataset Main address data.

.zlx Single Line Index File Indexing data for use with Single Line searching.

.tpx Typedown Index File Indexing data for use with Typedown searching.

Page 4 | Data Guide - Belgium

Data Guide

Belgium



About This Data
This chapter provides detailed information about the BEL dataset.

Area Covered
The BEL dataset covers all street addresses in Belgium.

Address Elements
The following address elements are stored within the BEL data files.

Address Element Example Element Code

Default street rue de Bretagne S11

Building number 2 P11

Postal code 1200 C11

Dutch street* Bretagnestraat S12

French street* rue de Bretagne S13

German street* Am Adesberg S14

Default province* West-Vlaanderen L11

Dutch province* Brussel-Hoofdstad L12

French province* Flandre Occidentale L13

German province* Westflandern L14

Default district Büllingen L21

Dutch district* Büllingen L22

French district* Bullange L23

German district* Büllingen L24

Default place* Bruxelles L31

Dutch place* Brussel L32

French place* Bruxelles L33

German place* Amel L34

Country name* Belgium X11

Two character ISO country code* BE X12

Three character ISO country code* BEL X13

* Elements that only appear in the address if their position is fixed.

Address Element Definitions

Postal Code Structure

A postal code in Belgium consists of a four-digit number, and typically covers a single locality. For example:

3000 LEUVEN
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The town name is commonly written after the postal code, on the same address line.

Forms Of Address

Forms of address are referred to as Country Views in Pro version 6 and earlier.

There are four Forms of address stored in the Belgium data files:

Form of address Description

1 CDF for Belgium Addresses returned in default language

2 Dutch-language form Addresses returned in Dutch

3 French-language form Addresses returned in French

4 German-language form Addresses returned in German

These provide alternative language versions of Belgium addresses. If you select one of the language-specific Forms then
addresses will be returned in that language, where possible. If an address is not available in the language specified, then
the address will be returned in its default language.

The Form of address determines which address elements are used in the returned address. For the Belgium dataset, the
street name, province, district and place elements vary according to the Form of address. Each address has entries in the
'default' elements, and may also have entries in some or all of the language-specific elements.

Instructions on how to change the Form of address in QuickAddress products are provided in the chapter "Using This Data"
on page 7.

Default Address Format

The default Belgium address format is the same for all Forms of address. The address is spread over two lines: the top
line contains the street name, followed by the building number; the bottom line contains the postal code, followed by the
district. The district is in upper case. By default, all other address elements are in mixed case. For example:

Sentillenhof 1
8000 BRUGGE
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Using This Data
This chapter provides search tips and other product-specific information when using Pro or Pro Web.

These searches are accurate at the time of data release. However, search results may differ depending on the data
release you are using.

With Pro
Forms of Address 

Forms of address are referred to as Country Views in Pro version 6 and earlier.

The Belgium dataset contains several Forms of address, as described on page 6. The default layout will return addresses
in the default Form of address. If you want to return addresses in a different Form you must set up additional address
layouts. You can either use the Configuration Editor or manually edit the configuration files.

Using the Configuration Editor

You can add a new layout in the Configuration Editor with the following steps:

1. In the Configuration Editor Layout Manager, double-click on Belgium. This expands the list of layouts that are set up.

2. Click on the New layout button on the toolbar. Alternatively, from the Layout menu, click New, or right-click Belgium
and choose New from the menu.

A dialog opens listing the available Forms of address.

3. Select the Form of address you want to use and click OK. The new layout is added to the bottom of the layout list.

4. Rename the new layout. For example, if you added a layout based on the Dutch Form, you might rename the layout
"Dutch". You can rename the layout at any time by right-clicking it in the list, and selecting Rename from the menu.

5. You can assign a hotkey for the new layout. When Pro is minimised, using a layout-specific hotkey will pop up the
program and automatically select that layout.

To assign a hotkey, click on the Hotkey field in the Layout Properties pane and press the keys you want to assign. For
example, if you have added a Dutch layout, click in the Hotkey field and press CTRL + D. When Pro is minimised, this
hotkey pops up Pro in the your Dutch layout.

It is recommended that you choose a hotkey not already in use by Pro (see the "Available Keystrokes" topic in the
Pro Help). You should also avoid common hotkeys, for example, CTRL + A. which in many Windows applications
means "Select All".For more information about hotkeys, see the Configuration Editor Help.

6. Save the changes you have made in Configuration Editor by clicking the Save button in the toolbar, or clicking Save
from the File menu, or pressing CTRL + S.

7. Close the Configuration Editor. The changes you have made will not take effect until you have closed and restarted Pro.

You can change the current layout in Pro Plug & Go by clicking Select Layout… from the View menu or pressing CTRL + L.
The Select Layout dialog opens. Choose the required layout from the list.

You can change the layout at any stage of your search. To view a returned address in a different layout, simply click Select
Layout… from the View menu, or press CTRL + L, and click the layout.

Page 7 | Data Guide - Belgium

Data Guide

Belgium



If you drag the Select Layout dialog to the side of Pro, you can preview the changes in the final returned address as you
browse different layouts.

Editing the Configuration Files

To manually set up an output address layout in your Pro configuration files you will need to use the CDFVariaton keyword
with the number of the Form of address as listed in the table on page 6. For example, to set a Belgium datamapping with
the identifier BEL to use the French-language Form you would add the following setting to your layout:

BELCDFVariation=3

For more information see the configuration section of your product documentation.

Search Examples: Typedown

The following table provides a list of these example search types:

l Full address known;

l Postal code not known;

l Dutch language address known.

Search type Example

Full address known 1. Enter the postal code, 6441, and press Enter.

2. Enter the first two letters of the street name, fr, and press Enter. In this
example fr is enough to uniquely identify rue Froidchapelle.

3. Enter the street number, 3, and press Enter.

4. The correct address is returned:

rue Froidchapelle 3
6441 ERPION

Postal code not known 1. Enter the first three letters of the location, wak, and press Enter. In this
example wak is enough to uniquely identify Wakken.

2. Enter the first two letters of the street name, vo, and press Enter. In this
example, vo is enough to uniquely identify Volderstraat.

3. Enter the premises number, 80, and press Enter. The correct address is
returned:

Volderstraat 80
8720 WAKKEN
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Search type Example

Dutch language address known In this example you are searching for the following dutch language address:

Sasstraat 3
1200 BRUSSEL

1. Enter the postal code, 1200, and press Enter. Note that the results area shows
Bruxelles, the French name for Brussels.

2. Enter the first three letters of the street name, sas. In this example sas is
enough to uniquely identify the street as rue de l'Ecluse. Note that the default
language (in this case French) is always used in the picklist. Press Enter.

3. Enter the premises number, 3, and press Enter.

4. The correct address is returned, according to the layout selected. The default
layout will return the French address:

rue de l'Ecluse 3
1200 BRUXELLES

Search Examples: Single Line

The following table provides a list of these example search types:

l Full address known;

l Postal code not known;

l Character missing from address;

l Address contains spelling mistake;

l French language address known.

Search type Explanation

Full address known Enter the street and building number followed by the postal code:

rue du sud,13,5140

The correct address is returned:

rue du Sud 13
5140 LIGNY

Postal code not known If the postal code is not known, enter the street name and building number
followed by the locality:

avenue centrale,19,marcinelle

The correct address is returned:

avenue Centrale 19
6001 MARCINELLE

Character missing from address If a character is missing from the address the unknown character can be
replaced with a question mark.

Enter rue de quinc?y,45 and the correct address is returned:

rue de Quinçay 45
5537 ANHÉE
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Search type Explanation

Address contains spelling mistake Entering an address that contains one or more spelling errors can still return
the correct address.

For example, entering safferstraat,42,2600 will still return the correct address:

Saffierstraat 42
2600 BERCHEM

French language address known In this example you are searching on a full French language address:

vieille rue,109,9600

The correct address is returned, according to the layout selected. The default
layout will return the Dutch address:

Oudestraat 109
9600 RONSE

Search Constraints

The following search constraints can be used to restrict searches when using the Single Line search engine in Pro .

Constraint Elements Restricted to Example

@L Province, district and place name liege@L

@X Postal code 1200@X

@S Street liege@S

@T District lim*@T

With Pro Web
The Belgium dataset contains several Forms of address, as described on page 6. Pro Web integrations can be configured
to use address elements relating to any Form of address. Refer to your Pro Web documentation for configuration
instructions. 

Details of how Forms of address can be configured are provided on page 7.

Scenarios

The following table indicates the relevant search examples for each Pro Web scenario and search engine that supports
BEL address data.

Scenario Search engine For search examples, see:

Address Capture
on the Intranet

Single Line
hierarchical

Single Line search examples on page 9.

Address Capture
on the Web

Single Line
flattened

Single Line search examples on page 9.

Address Capture Single Line
flattened

Single Line search examples on page 9.

Single Line Single Line
hierarchical

Single Line search examples on page 9.
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Scenario Search engine For search examples, see:

Standard Typedown

Single Line
hierarchical

Typedown examples on page 8.

Single Line search examples on page 9.

ActiveX Control Typedown

Single Line
hierarchical

Typedown examples on page 8.

Single Line search examples on page 9.
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